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System Requirements                                                                                          
Windows 2000 SP4
Windows XP SP2, Windows XP SP3
Windows Server 2003
Windows Vista, Windows Vista SP1
Windows Server 2008
Windows x64-bit platform
Installation requires administrator’s privileges.
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New Features & Enhancements                                                                                                      
New DBCS conversion (v8.51.02)
The QRCode and DataMatrix barcodes now use direct encoding in DBCS instead of using the UnicodeToDBCS formula.
New OCX field (v8.51.02)
This new object type allows you to use a third-party OCX component inside your label.
New formulas (v8.51.02)
New formulas are now available:
Week (calculate week number ISO8601), Extract (extract string from a string), ReplaceString (replace string occurrence(s) with another
string)
Space correction for DataMatrix (v8.51.02)
This option allows you to provide space correction between barcode elements.
This can be useful for inkjet printing.
New barcode symbologies (v8.51.01)
Chinese sensible code.
ITF14 supports more option for lines/boxes that surround the code.
New GHS pictograms (v8.51.01)
New pictograms based on GHS normalization are added to the Image Gallery.
New Compliance labels (v8.51.01)
New compliance labels are provided for different areas like Retail, Shipping, Healthcare, and Automotive.
New barcode symbologies (v8.51)
Code 49, Intelligent Mail (USPS 4-State), ISBN-13, and RSS expanded stacked.
New Formulas (v8.51)
New formulas are now available to allow calculation of the “Best before date” and “Expiration date” at print time:
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BestBefore, DateValue, DateOffset
Database loops (v8.51)
It is now possible to specify the number of times a set of records should be printed when using a database.
Refresh table lookup at print time (v8.51)
The Refresh table lookup at print time option allows the system to reevaluate table lookup fields in a document at print time to ensure
the most current information is used.
Silent installation (v8.51)
CODESOFT installation can be run in Silent mode, using the basic command line "<Path>\Setup.exe" /s /v"/qn INSTALLLEVEL=150".
This command installs CODESOFT in English in the default folder with all features. For additional parameters, refer to the TEKLYNX
web site or the online help.
Pre-requisite installation (v8.51)
CODESOFT pre-requisites (.NET framework 2.0 SP1, MDAC 2.8, Adobe Acrobat Reader 8) are now automatically installed if necessary.
Guides (v8.51)
Quick Start Guide and Administrator’s guide are now directly accessible from the Help menu.
Label Background with image (v8.50.07)
A new Extended tab in Document Properties allows you to define a background. The user can select an image and different options to
define the background that applies to the current label.
OCX Component (v8.50.07)
A new OCX control named “Labeling Manager control” is provided. This allows easy integration with Microsoft Office applications.
Resolution independent (v8.50.05)
Allows you to design labels that will be printed identically on different printers (office or thermal printers). To access to this option, use the
command File > Properties > Preview.
New User interface language (v8.50.05)
Romanian language is now available for the User Interface.
Requery button (v8.50.05)
A Requery button has been added in the Query result dialog box. This command runs the query and updates the grid.
Windows graphical emulation (v8.50.04)
Enables you to standardize printing of your labels irrespective of the printer selected (Thermal printers or Windows printers). Use the
command File > Properties > Preview to access this option.
Wizard Upgrade tool (v8.50.02)
This tool eases updates from CODESOFT 8 to CODESOFT 8.5. It allows you to transfer the settings and files from the previous version
to the new one. You can launch it from C:\Program Files\TKI\8\Common\Tools\WizardUpgrade\UpgradeWizard.exe.
New Wizards (v8.50)
New wizards ease the creation of:
- Documents
- Objects, such as Text, Barcode, and Image
- Variables like Counter, Form, Free, and Date.
The wizards can be activated and deactivated individually.
Enhanced menu look and feel (v8.50)
A new look and feel for menus is now available. This is similar to what is available in Office 2003. Two themes are available.
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Enhanced Open dialog box (v8.50)
The new open look and feel for the Open dialog box is used. This provides the left toolbar icons with direct access to some pre-defined
folders.
Enhanced Print dialog box (v8.50)
The Print dialog box now includes several tabs when expanded.
This will allow you to check, based on current print settings (number of labels, pages, etc.) whether printing is optimized using the
Performance tab.
Text Vertical alignment (v8.50)
This option allows you to define a vertical alignment for text paragraph. This option is only available with the Fit to frame option.
Text on any angle (v8.50)
In the Shape Settings tab, the Polyline shape option allows the user to select any kind of shape.
This option can be very useful in conjunction with a text art to position text on any angle.
Label Background definition (v8.50)
It is now possible to select a label background without having to use a name based on the stock type/name.
A new Background combo box allows you to select the EMF/WMF file that will be used as the label background.
The EMF/WMF files need to be published in the C:\Program Files\TKI\8\Common\LFM directory.
Network licensing (v8.50)
A new range is available through Network licensing: Runtime.
For License Manager, the Shared folder is changed.
On Vista, you must share "C:\Programdata\TKI\LicenseManager\TkDongle" as "TkDongle" and on the other systems you must share
"C:\Documents and Settings\All Users\Application Data\TKI\LicenseManager\TkDongle" as "TkDongle."
Folder reorganization (v8.50)
Here is the description of the new folder reorganization.
Samples & Tutorial
Sample Labels
Sample Forms
Sample Compliance
Tutorial
Common files

<All
<All
<All
<All

Users
Users
Users
Users

Profile>\Documents\Teklynx\CODESOFT\Sample\Labels
Profile>\Documents\Teklynx\CODESOFT\Sample\Forms
Profile>\Documents\Teklynx\CODESOFT\ Sample\Compliance
Profile>\Documents\Teklynx\CODESOFT\Tutorial

Data files (including databases)
Describers
Specific Formulas
Image Gallery
Images
Patterns
Queries
Shapes
Print files
Application configuration files

<All Users Profile>\Documents\Teklynx\Common\Data
<All Users Profile>\Documents\Teklynx\Common\DSC
<All Users Profile>\Documents\Teklynx\Common\Formulas
<All Users Profile>\Documents\Teklynx\Common\Galleries
<All Users Profile>\Documents\Teklynx\Common\Images
<All Users Profile>\Documents\Teklynx\Common\Patterns
<All Users Profile>\Documents\Teklynx\Common\Query
<All Users Profile>\Documents\Teklynx\Common\Shapes
<All Users Profile>\Documents\Teklynx\Print
(Files created by the application and its tools/add-ons)

Shared variables files
Network printers settings
Product config files (user.ini and
user.bar)

<CommonAppData>\Teklynx\System\Globvar
<CommonAppData>\Teklynx\System\Printers
<CommonAppData>\Teklynx\System\<ProductRange>

<ProductRange> is the range of the product; for example, Enterprise, Pro, or Lite.
Superimposing (v8.10)
This is an optional feature that allows you to superimpose objects to preserve the readability or physical space on the label. This feature
is useful when using a barcode to prevent any other object from being overlaid on top of it. This feature can be enabled by going to the
General tab of the object’s properties.
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Norm GS1 (v8.10)
Choosing to use the GS1 norm enables barcode verifications according to GS1 (formerly EAN) recommendations.
This new option is available in Tools > Options dialog box > Others tab. When the option is enabled, it will check that the barcodes
conform to the different requirements of the GS1 normalization, such as narrow bar size, check digit, and human-readable.
RFID (v8.10)
A new RFID button, available on the toolbar, provides a direct link to the RFID settings.
TKTEXTIL.TTF (v8.10)
New symbols have been added in TKTextil.ttf to fulfill the COFREET requirements. Refer to the TKTextil.lab sample file.
Database Manager (v8.10)
The User Interface of the Database Manager has been improved making it more intuitive and easy to use.
The general user interface has been refreshed to give it a better look and feel.
A new menu entry (File > Open) allows the user to directly open a basic database file (Access, Excel, dBase).
It is now possible to create duplicate record(s) with a single right-click on selected records.
More feedback is provided to the user when operations cannot be performed (limited user rights, not compliant with database
structure, etc.).
It is possible to limit the Database Manager features by modifying the file C:\Program
Files\TKI\8\Common\Tools\DMan\ProductSettings.cfg. (Note: This feature is for advanced users only.)
It is now possible to customize the display font.
Print by printer resolution (v8.10)
Uses an algorithm independent to the paper format, to send only the positions and sizes linked to the Windows printer’s resolution.
The current print algorithm adjusts object size and position when you switch, for instance, from a A4 page to Letter page (on a Windows
printer). This is similar to the method used in Microsoft Word, and the advantage is that the objects are adjusted at print time so that
everything fits on the page/label. The new print algorithm only uses the printer resolution, which means that the object’s position and
size are fixed, but at print time, you may notice that some objects are outside the page/label or partially cut.
ActiveX
VC++ and C# ActiveX samples available on CD have been updated to demonstrate how to use Events.
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New Device Support                                                                                    
The following devices and their associated drivers have been added in this version:
V8.51.01
Manufacturer
BROTHER

COGNITIVE

TALLYGENICOM

ZEBRA

Model
Brother MW-140BT
Brother MW-260
Brother QL-1060N
Brother RL-700S
Cognitive AdvantageDLX DBD24-2085-xxx
Cognitive AdvantageDLX DBT24-2085-xxx
Cognitive AdvantageDLX DBD42-2085-xxx
Cognitive AdvantageDLX DBT42-2085-xxx
TallyGenicom 7005 DT2 (203dpi)
TallyGenicom 7005 DT4 (203dpi)
TallyGenicom 7005 TT4 (203dpi)
Zebra GK420d EPL
Zebra GK420t EPL
Zebra GX420d EPL
Zebra GX420t EPL
Zebra GX430t EPL
Zebra GK420d ZPL
Zebra GK420t ZPL
Zebra GX420d ZPL
Zebra GX420t ZPL
Zebra GX430t ZPL
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VIDEOJET

ICE

MARSH

LINX

VIDEOJET VJ2310
VIDEOJET VJ2320
VIDEOJET VJ2330
ICE Torus 126
ICE Torus 380
ICE Torus 500
Marsh 1100
Marsh 2100
Marsh 3100
Linx IJ350
Linx IJ370

V8.50.08
Manufacturer
TALLYGENICOM

BRADY          

ZEBRA

CITIZEN          

IMAJE
MARKEM

Model
TallyGenicom MTP4P
TallyGenicom MTP4P EPL
TallyGenicom MTP4P ZPL
TallyGenicom 7006 DT2 (203dpi)
TallyGenicom 7006 DT2 (300dpi)
TallyGenicom 7006 DT4 (203dpi)
TallyGenicom 7006 DT4 (300dpi)
TallyGenicom 7006 TT2 (203dpi)
TallyGenicom 7006 TT2 (300dpi)
TallyGenicom 7006 TT4 (203dpi)
TallyGenicom 7006 TT4 (300dpi)
TallyGenicom 7008 DT2 (203dpi)
TallyGenicom 7008 DT2 (300dpi)
TallyGenicom 7008 DT4 (203dpi)
TallyGenicom 7008 DT4 (300dpi)
TallyGenicom 7008 TT2 (203dpi)
TallyGenicom 7008 TT2 (300dpi)
TallyGenicom 7008 TT4 (203dpi)
TallyGenicom 7008 TT4 (300dpi)
Brady BBP81 200
Brady BBP81 300
Brady BBP81 600
MZ 200
MZ320
Zebra RW 220 ZPL
Zebra RW 420 ZPL
Zebra RW 220 EPL
Zebra RW 420 EPL
Zebra RW 220
Zebra RW 420
CLP-521z
CLP-621z
CLP-631z
Imaje 5000 53 mm
Imaje 5000 107 mm
Markem 9096 (Inkjet printer)

V8.50.07.01
Manufacturer
BRADY

BETAPRINT

Model
BBP81 200
BBP81 300
BBP81 600
Betaprint 55SST Continuous
Betaprint 55SST Intermittent
Betaprint 128SST Continuous
Betaprint 128SST Intermittent

V8.50.07
Manufacturer
DOMINO

Model
Domino
Domino
Domino
Domino
Domino
Domino

CM5
IM5
V100
V200
V300+ 2" CM
V300+ 2" IM
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SATO

ZEBRA

Domino
Domino
Domino
Domino
CT408i
CT412i
CT424i

V300+ 5" CM
V300+ 5" IM
V400 2"
V400 5"

110XiIII
110XiIII
110XiIII
110XiIII
110XiIII
110XiIII

Plus
Plus
Plus
Plus
Plus
Plus

UHF (203dpi)
UHF (300dpi)
UHF (600dpi)
HF   (203dpi)
HF   (300dpi)
HF   (600dpi)

V8.50.06
Manufacturer
SATO

Model
GL408e
GL412e

V8.50.05
Manufacturer
DATAMAX

SATO CX 410

ZEBRA

Model
M-4206 Mark II
M-4210 Mark II
Lt408 (RH)
Lt408 (LH)
MB400i
MB410i
ZM400
ZM400
ZM600
ZM600

(203
(300
(203
(300

dpi)
dpi)
dpi)
dpi)

V8.10.04
Manufacturer
DATAMAX
Version: 32.03.04

Model
DATAMAX H CLASS

ITW BETAPRINT
Version : 32.01.02

TP2100
TP4000

SATO
Version: 31.03.01

S8408 (RH)
S8408 (LH)
S8412 (RH)
S8412 (LH)
S8424 (RH)
S8424 (LH)
MB200i

ZEBRA
Version 31.06.00

QL
QL
QL
QL
QL
QL

220
320
420
220
320
420

Plus
Plus
Plus
Plus
Plus
Plus

ZPL
ZPL
ZPL
EPL
EPL
EPL

V8.10.02
Manufacturer
DATAMAX
Version: 22.24.00

Model
DATAMAX H CLASS
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Fixed Defects                                                                                                   
Version

Ticket ID/
Defect ID

Description

34391-16068

Excel files with field names that contain Chinese characters were not working

8.51.02
33780-15966

Printouts for DataMatrix/QR code that contain Chinese characters were not working

32222-15961

Barcode wizard could not enter alphabetical characters for DataMatrix

35324-16221

WYSIWYG problem with Eltron TLP-3642

31161-15576

Counters with value outside of the alphabet were not accepted at print time (backward compatibility with
version 6) – a warning is displayed at creation time
Lite or Pro versions are no longer able to lock objects.

8.51.01

29434-15335
27277-14994

Maxicode wizard did not generate valid default data regardless of selected mode

32486-15747

Display was not correct when using formulas that reference other formulas

8.51.00
24884-14218

Decrementing hexadecimal counter was not decrementing properly

14249-12208

Printer speed switch was ignored when printing from SENTINEL

25866-14508

EAN-14 can now be based on EAN-128 or ITF-14 symbology

20913-13318

Some characters’ descenders were cut off (for example, the bottom portion of “g”) in Rich Text fields

11697-13708

In the Runtime version, the printable or non-printable option for objects can now be set through ActiveX

8.50.08
24480 - 14121

On some configurations, CODESOFT takes longer than usual to start

24947 - 14241

Database records were not refreshed before printing using table lookup data sources

21761 - 14358

Empty variables could cause a system crash if using SENTINEL

25468 – 14386

Unable to create a graphic barcode EAN13 EXT5 and EXT2

25472 – 14389

Non-printable barcode linked to a data source was printed

25768 – 14491

In the Runtime version using ActiveX, the Close method returned an error

00 - 13652

Monochrome image with reversed palette does not open in reverse mode

8.50.07.01
8.50.07
15802 - 12425

Labels cannot be modified when in use by SENTINEL TKXPECU

20625 – 13212

Database Manager did not work with Excel files

00 - 13097

Name of barcode was changed when editing then canceling its properties

00 - 10603

Impossible to decrease printer barcode height using down arrow button

15695 - 12400

Using date settings, when switching to a date managed by the printer, the current format is kept if the printer
supports it
Opening a label using the Microsoft Office Document Image Writer printer may cause the application to crash
Date and time were not refreshed when printing a label if Update date during printing option was not set
Formula counter was not updated when data was set using the Form

8.50.06

00 - 12335
17881 - 12801
17895 - 12808
8.50.05
9630 - 11588
10386 - 11638
9937 - 11605
11696 – 11738
12602 - 11878
13024 - 11975
00 - 12178
13214 - 12018
13742 - 12105

@labelcpy and @serialqty variables were not updated in formulas
SQL warning messages do not display in table Lookup; only error messages are
User Manager: new profile was created with no option
When the Network connection is broken, shared variables detect this disconnect
Upgrades from previous 8.x versions are fully managed
Margins were not considered when printing from SENTINEL (label was always printed with margins set to 0,0
).
Specific options with barcode are now available
Error in transparent background handling is corrected
A variable PDF barcode with a non valid data was displayed on the label and preview but was not printed.

8.50.04
2466 - 11032

Paragraph field management is optimized for TEC printers when using different true type font attributes (size,
bold, italic, etc.)
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3118 - 11242
4775 - 11257
6008 - 11379
9107 - 11563
9109 - 11564
9564 - 11584

Aztec barcode: The pipe character was misinterpreted
The management of multiple symbols is now allowed
The movement of empty objects now follows mouse cursor
Using Windows 2003 Server with software key version, the lppa.exe process is now freed from memory when
the application is closed
Full justified paragraph text causes error on Windows printer
When printing with Query result view, if the database was updated, erroneous data could be printed
The ActiveX method “Document.Copyimagetofile” with a negative rotation result with a rotation always set to
45°
back to top

Known Limitations                                                                                                
·       While

installing CODESOFT on Microsoft Windows 2000 SP4, you may encounter the following error message: “The procedure
entry point HeapSetInformation could not be located in the dynamic link library KERNEL32.dll.” CODESOFT includes all the
prerequisites required by the product, and will install the prerequisites when they are not already installed on the machine. This
error occurs when Microsoft .NET Framework 2.0 SP1 setup fails on Microsoft Windows 2000 SP4. To solve the problem, install
the Security Update for Microsoft Windows, as described in Knowledge Base article KB835732 at http://support.microsoft.com/.

·       Under

Windows Vista SP1, BACKTRACK 6 doesn’t detect CODESOFT. To solve this issue, you have to start BACKTRACK once
using an administrator account.

·       When

you start CODESOFT, the application takes longer than usual to start. This is a known issue identified by Microsoft in
Knowledge Base article 936707 at http://support.microsoft.com/. This applies to .NET 2.0 assemblies with Authenticode
signature. This problem occurs because the affected computer cannot reach the following Microsoft web site:
http://crl.microsoft.com/pki/crl/products/CSPCA.crl.
If the problem occurs, here are two solutions proposed by Microsoft:
- Install Microsoft .NET 2.0 SP1 or Microsoft .NET 3.5.
or
- Disable the Check for publisher's certificate revocation option in Internet Explorer Advanced Options.

·       Microsoft

defect with Vista: When you upgrade from a previous version of CODESOFT 8.5, the Windows installer does not
always install MFC8 modules. We recommend uninstalling the previous version of CODESOFT before installing the new one. If
you have already installed CODESOFT and it does not start, you can solve the problem by installing the MFC8 modules using the
Microsoft redistributable vcredist_x86.exe. This redistributable is provided on the CODESOFT CD (under
Software\Misc\vcredist_x86) or can be downloaded from the Microsoft web site.

·       Please

note that if using Windows 2008 version, you may need administrator's rights to perform some actions like adding a printer
with non-direct access or creating a System DSN data source. Please verify that you have sufficient rights before performing
these actions.

·       Query

definition only supports tables within the default schema. If it is necessary to use a table from another schema, the SQL
mode should be used, using a syntax like: SELECT * FROM Schema.Table.

·       The

Database Manager is a generic database tool that relies on OLE DB Provider (ODBC is not supported). OLE DB Provider or
the DBMS itself can both have some limitations. For example, with an Access database, when you set three unique fields in
Database Manager, only the first one will be set. The recommendation is to use the internal DBMS tools to modify database
structure, especially when working on advanced actions (like multiple constraints and primary key modification). The same is true
for big tables where the response time can be slow on some operations.

The sample forms designed to demonstrate the Form Designer and Form Viewer need to have the following folder selection in
order to work (the default path set during installation). This folder selection can be modified in Tools > Options > Default Folders
tab.  
C:\Documents and Settings\All
- Document (*.xmf):
Users\Documents\Teklynx\CODESOFT\Samples\Forms
C:\Documents and Settings\All
- Labels:
Users\Documents\Teklynx\CODESOFT\Samples\Labels
- Image:
C:\Documents and Settings\All Users\Documents\Teklynx\Common\Images
A database connection must be linked to the DatabaseGrid control displayed in sample form DBForm.xmf in order to show
information (for example, identity.mdb).  
Microsoft defect: MFC Applications leak GDI objects on computer running Windows Server 2003 or Windows XP. Refer to article
319740 in the Microsoft Knowledge Base: http://support.microsoft.com/.
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For fully Chinese-sensible code support under winXP\2003\2000 following prerequisites are required:
- GB18030 support package should be installed: http://www.microsoft.com/downloads/details.aspx?familyid=fc02e2e3-14bb-46c1afee-3732d6249647&displaylang=en.
- Files for East Asian languages should be installed.
For Windows XP/2003: 54936 Gb18030 Simplified Chinese codepage should be selected.
Note that for Windows 2000, selection of 936 codepage is enough.
·      The label version is guaranteed when using ascending version. When using a different a version, please check that all versions
are in the same range:
Backward Compatibility Range
                         CD Masters
CS800_XX_R1
8.00.00 – 8.00.05

8.00.06 – 8.00.08

8.00.09 – 8.00.10
8.10.00 – 8.10.02

8.50.00
8.50.01 – 8.50.03

8.50.04
8.50.05
8.50.06
8.50.07 – 8.50.08

8.51
8.51.01

CS800_XX_R2
CS800_XX_R2_121605
CS800_XX_R2_010606
CS800_XX_R2_020106
CS800_XX_R2_030806
CS800_XX_R2_041206
CS800_XX_R2_052206
CS800_XX_R2_062906
CS800_XX_R2_080106
CS800_XX_R2_100206
CS800_XX_R3_061212
CS800_XX_R3_061214
CS800_XX_R3_070201
CS850_XX_R1_070511
CS850_XX_R1_070619
CS850_XX_R4_070713
CS850_XX_R4_070927
CS850_XX_R4_071120
CS850_XX_R4_080215
CS850_XX_R4_080402
CS850_XX_R4_080521
CS850_XX_R4_080620
CS850_XX_R4_080901
CS850_XX_R5_081002
CS850_XX_R5_090126
CS850_XX_R5_090206

8.51.02
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3rd Party Components and Files                                                                                          
Installation of CODESOFT may upgrade your system with third-party components and files.
These files are not yet Windows Server 2008 logo compliant; they may lack some versioning information (like company name or version
number), or they may lack a digital signature.
The list of files that could be added by CODESOFT's installation are produced by the following companies: Macromedia for InstallShield
items, Veritech and Symbol Technologies, Inc. for barcode modules, Eastman Kodak and Data Techniques, Inc. for image modules and
Microsoft for Visual C++ items.
File created by InstallShield during install:
C:\Windows\Installer\{206F510A-F0B3-480A-9FDD-9C0EBC8FCAC6}\ARPPRODUCTICON.exe

Files created by Veritech and Symbol Technologies, Inc. for barcode modules:
C:\Program Files (x86)\TKI\8\Common\Vericode.dll
C:\Program Files (x86)\TKI\8\Common\PDFENC32.DLL

Files created by Eastman Kodak and Data Techniques, Inc. for image modules:
C:\Program Files (x86)\TKI\8\Common\imgman32.dll
C:\Program Files (x86)\TKI\8\Common\PCDLIB32.DLL

Components from Microsoft:
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C:\Windows\SysWOW64\JETCOMP.exe
C:\Windows\SysWOW64\msexch35.dll
C:\Windows\SysWOW64\msexcl35.dll
C:\Windows\SysWOW64\msjet35.dll
C:\Windows\SysWOW64\msjint35.dll
C:\Windows\SysWOW64\msjt4jlt.dll
C:\Windows\SysWOW64\msjter35.dll
C:\Windows\SysWOW64\msltus35.dll
C:\Windows\SysWOW64\mspdox35.dll
C:\Windows\SysWOW64\msrd2x35.dll
C:\Windows\SysWOW64\msrepl35.dll
C:\Windows\SysWOW64\msrpfs35.dll
C:\Windows\SysWOW64\mstext35.dll
C:\Windows\SysWOW64\msxbse35.dll
C:\Windows\SysWOW64\VBAR332.DLL
C:\Windows\winsxs\x86_microsoft.vc80.atl_1fc8b3b9a1e18e3b_8.0.50727.762_none_11ecb0ab9b2caf3c\ATL80.dll
C:\Windows\winsxs\x86_microsoft.vc80.crt_1fc8b3b9a1e18e3b_8.0.50727.762_none_10b2f55f9bffb8f8\msvcm80.dll
C:\Windows\winsxs\x86_microsoft.vc80.crt_1fc8b3b9a1e18e3b_8.0.50727.762_none_10b2f55f9bffb8f8\msvcp80.dll
C:\Windows\winsxs\x86_microsoft.vc80.crt_1fc8b3b9a1e18e3b_8.0.50727.762_none_10b2f55f9bffb8f8\msvcr80.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfc_1fc8b3b9a1e18e3b_8.0.50727.762_none_0c178a139ee2a7ed\mfc80.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfc_1fc8b3b9a1e18e3b_8.0.50727.762_none_0c178a139ee2a7ed\mfc80u.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfc_1fc8b3b9a1e18e3b_8.0.50727.762_none_0c178a139ee2a7ed\mfcm80.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfc_1fc8b3b9a1e18e3b_8.0.50727.762_none_0c178a139ee2a7ed\mfcm80u.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80CHS.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80CHT.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80DEU.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80ENU.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80ESP.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80FRA.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80ITA.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80JPN.dll
C:\Windows\winsxs\x86_microsoft.vc80.mfcloc_1fc8b3b9a1e18e3b_8.0.50727.762_none_43efccf17831d131\mfc80KOR.dll
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Compatibility with Other TEKLYNX Software
CODESOFT 8.51.02 is compatible and fully tested to work with the following TEKLYNX software packages:
·          LABEL ARCHIVE 2.06
·          SENTINEL 5.06
·          BACKTRACK 6.0
·          IDEAM 6.0
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companies. All other brands and product names are the trademarks of their respective owners.
This release notes document is for informational purposes only. Product specifications are likely to change.
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